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This document provides instruction for creating a customized asset management plan template for your 
specific agency by using the “CulvertAMP _v####.xlsm” tool and accompanying folders and files 
(including “CulvertAMDoc_v####.docm”, “CulvertAMP_v####.docm”,  and 
“MichiganAgencyCulverts.csv”), distributed to you by the Center for Technology & Training (CTT) in 
collaboration with the Transportation Asset Management Council and the Michigan Department of 
Transportation.  

Culvert asset data for your agency will need to be entered into the Microsoft Excel tool. Your agency’s 
culvert data can be exported from Roadsoft or the database of your choice; data should be saved in .csv 
format.  

Another portion of the culvert asset data for the customized Microsoft Word template relies on your 
agency’s answers to asset management questions in the tool. The tool will parse the data for the Microsoft 
Word template. This Instruction Guide will detail how to enter data into the Excel workbooks and, 
subsequently, generate a customized culvert asset management plan template in Word. 

 

 

 

 

 

 

 

 

 

 

 

 

For more information  
 

Select this symbol to learn more information about the tool. 

 

Select this symbol to discover where related requirements and/or recommendations can be found. 
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Saving the tools on your computer 
The tools for creating a customized culvert asset management plan template can be downloaded as a 
zipped file from ctt.mtu.edu/asset-management-resources. After unzipping the tools folder, it is 
recommended that the “culvertamp_v####_tools” folder be saved in your Documents or My Documents 
folder or on your desktop; if it is desired to rename this (sub)folder, use a unique name such as 
“CulvertAMP-2025”. Please note: DO NOT RENAME the included folders or files at any time. Also, if 
your computer system backs up your files to an online cloud service, you will need to save the asset 
management plan tools to a USB drive and work with the files on the USB drive.  

The tools within the “culvertamp_v####_tools” folder consist of (see figure below): 

 the .xlsm file, “CulvertAMP_v####.xlsm”, housed in the main folder 

 two subfolders 

o the “backgroundprocesses” subfolder that contains the generic Word templates 
“CulvertAMDoc_V####.docm”  and “CulvertAMP_V####.docm” 

o the “csvCulvertData” subfolder that contains a generic dataset 
“MichiganAgencyCulverts.csv” and that serves as a repository for your agency’s actual 
data in .csv format.  

Do not rename these files or folders. 

It is also recommended that any other content needed for your culvert asset management plan—such as 
logos and images—be kept in this folder, as well. 
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Obtaining your culvert data exports 

Exporting culvert data from Roadsoft 
To create a customized culvert asset management plan template, you will need an export of your culvert 
inventory and condition rating data.  

To export culvert asset data from Roadsoft: 

Coming soon (May/June 2025)! 

 

NOTE: If you need to save your data export in .csv format, open Excel, select File > Open, navigate to 
the culvert data export file and select Open, and then save the file as a .csv file (“CSV (Comma 
delineated)”). 

 

 

Exporting culvert data from other database 
NOTE: Your agency can use culvert data stored in a database other than Roadsoft. The exported data must 
be saved in .csv file format. Data needed to build a customized culvert AMP template includes culvert 
identification number, material, asset owner, shape, width and width unit, span and span unit, rise and rise 
unit, length and length unit, height or diameter and height/diameter unit, PR number, PR name, number of 
culverts, milepoint, intersection/between roads, culvert barrel rating, and vicinity and appurtenant 
structure rating. 

1. Export data from the database following the instructions given by the database developer. 

2. Save your export as a .csv file. 
 

NOTE: If you need to save your data export in .csv format, open Excel, select File > Open, navigate 
to the culvert data export file and select Open, and then save the file as a .csv file (“CSV (Comma 
delineated)”). 

 

Saving your culvert data exports 
Find your culvert data export(s). Copy or cut the export file(s) and paste the file(s) in your 
“culvertamp_v####_tools” folder “csvCulvertData” subfolder. 
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Entering data into the CulvertAMP_v####.xlsm tool and 
producing a customized template 
The CulvertAMP_v####.xlsm tool is an Excel workbook that allows you to enter and process your 
agency’s culvert data and will subsequently populate a Word template, which you can further personalize 
for your agency’s culvert asset management plan. This tool runs calculations in the background so that the 
data you enter will be parsed into the appropriate formats for the culvert asset management plan. 

NOTE: Several worksheets in the CulvertAMP_v####.xlsm tool are protected to prevent inadvertent 
changes. A number of those protected worksheets require a password to unprotect the sheet. If a 
worksheet is password protected and you wish to modify it, the password is “password”. 

 

Using the .xlsm Tool for the First Time and Setting a Trusted Location 
You will see a security warning when you open a macro-enabled Microsoft Office file for the first time. If 
this file is from a trusted source, select Enable Content. 

NOTE: You must enable macros for this workbook to function. 

 

You will also need to set the folder containing your bridge asset management plan tools as a trusted 
location. 

NOTE: This set of directions will work for setting trusted locations through either Microsoft Word or 
Excel. 

1. Select File. 
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2. Select Options. 

 

 The Word Options window will appear. 
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3. Select Trust Center in the Word Options menu. 

 

4. Select Trust Center Settings… 

 The Trust Center window will appear. 
 

5. Select Trusted Locations in the Trust Center window menu. 
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6. Select Add new location….  

 The Microsoft Office Trusted Locations window will appear. 

7. Select Browse. 
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 The Browse window will appear. 

8. Browse to the folder you wish to set as a trusted location and select that folder in the main pane of 
the window; select OK.  

 

 The selected folder’s path should appear in the Microsoft Office Trusted Locations window. 

9. Select Subfolders of this location are also trusted; then, select OK. 
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10. In the Trust Center window, select OK.  

 Your selected folder has now been set as a trusted location. 
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Instructions Worksheet 
NOTE: When you open the CulvertAMP_v####.xlsm tool, you will be greeted with a welcome message 
in the Instructions worksheet. Please read the entire sheet before beginning. Then:  

1. Select Let’s Get Started.(see figure below). 

 

 

 The  Culvert TOC sheet and the Select ‘Let’s Get Started’ to begin dialogue box will display (see 
figure below). 
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Culvert TOC Worksheet 

1. In the Select ‘Let’s Get Started’ to begin dialogue box, select OK (see figure below). 

 

2. Select LET’S GET STARTED to continue (see figure below). 

 

 The  Would you like to skip to the culvert dashboard dialogue box will display (see figure below). 

3. Select Yes or No in the Would you like to skip to the culvert dashboard? Dialogue box to continue 
(see figure below). 



12 
 

 

 If you selected Yes: 

a. Select View next to Culvert Dashboard in the table of contents to view and export the culvert 
dashboard as a graphic (see…). CHANGE PIC 

 

 If you selected No: The Would you like to generate… dialogue box will display (see figure below). 

b. In the Would you like to generate… dialogue box,  
…select Yes if you would like to generate a standalone culvert asset management plan (see 
figure below). 

OR 

… select No if you would like to generate a culvert asset management plan insert for the PA 
325 compliance plan (see figure below). 
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NOTE: The PA 325 compliance plan’s chapter on culvert assets accounts for failed culverts. This 
accounting uses an obsolete system of inventory and condition data collection that was used in 
the 2018 Michigan culvert pilot. In the process of generating an insert, data on ‘failed’ culverts is 
collected for the compliance plan chapter on culvert assets and the insert itself accounts for the 
difference in data collection systems to back up the data presented in the chapter. 

 

 This selection will make the appropriate Generate… button will display. The Import data from 
Roadsoft or other data set dialogue box will also display (see figure below). 

i. In the Import data from Roadsoft or other data set dialogue box,  
…select Yes if your data is in Roadsoft exports (see figure below). 

OR 

… select No if your data is in another database export (see figure below). 
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 If you selected Yes, the Please use the file dialog box to find and select your culvert 
INVENTORY data file dialogue box will display (see figure below). 

a. Select OK in the Please use the file dialog box to find and select your culvert INVENTORY 
data file dialogue box (see figure below). 

 

 The Please select your culvert INVENTORY data file [.csv OR .jsp] dialogue box will 
display (see figure below). 

b. Select the file CulvertExport.csv file and select Open (see figure below). 

 

 The Please select your culvert CONDITION data file [.csv OR .jsp] dialogue box will 
display (see figure below). 
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c. Select the file CulvertInspLast.csv file and select Open (see figure below). 

 

 The CulvertData worksheet will display (see figure below). 
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CulvertData Worksheets 

NOTE: The CulvertData and CulvertData2 worksheets require a Roadsoft export dataset. By selecting 
Let’s Get Started on the CulvertTOC worksheet, you will be guided through the importing of your data. 
If this process fails, you may unhide the CulvertData and CulvertData2 worksheets, unprotect the 
worksheets, copy the data in the CulvertExport.csv file into the appropriate columns in the CulvertData 
worksheet, and copy the data in the CulvertInspLast.csv file into the appropriate columns in the 
CulvertData2 worksheet. The steps for manually importing your data are detailed in a note after Step 3. 

 

1. Review the data in the CulvertData worksheet. 

2. Select the Done button at the top of the Culvert Inventory Data worksheet (see figure below).  

 

NOTE: If you need to edit any of the imported culvert data, select Edit Data. You will be given the 
choice to select a new data set to import or simply to edit the data set that is already placed. When 
done, select Edit Data again, and select Done (see figures below). 
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3. Select the Done button at the top of the Culvert Condition Rating Data worksheet (see figure below). 

 

 The Identify marker dialogue boxes will display (see figure below). The defaults will be ‘Good’, 
‘Fair’, ‘Poor’, and ‘Severe’, OR ‘GOOD’, ‘FAIR’, ‘POOR’, and ‘SEVERE’ as found in the culvert 
barrel condition rating column; if some other marker was used to identify these conditions, enter that 
marker when prompted. 

 
4. For each of the Identify marker dialogue boxes, select OK (see figure below). 

 



19 
 

 The Culvert AMP First Year of Work Plan dialogue box will display (see figure below).  

 

5. In the Culvert AMP First Year of Work Plan dialogue box, enter the year/first year reflected in this 
culvert asset management plan (see figure below). 

 

6. Select OK (see figure below).  

 

 The cInputsMaintenance worksheet will display.  
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cInputsFailed Worksheet (For Compliance Plan Culvert Insert Only) 

NOTE: The cInputsFailed worksheet requires your selection of the severe culverts, which are 
compiled into this list, that could be considered failed. This worksheet is for the compliance plan 
culvert insert only. The PA 325 compliance plan’s chapter on culvert assets accounts for failed 
culverts. This accounting uses an obsolete system of inventory and condition data collection that was 
used in the 2018 Michigan culvert pilot. The insert itself accounts for the difference in data 
collection systems to back up the data presented in the compliance plan chapter. 

1. Select any culvert that could be considered failed by check marking the culvert in column A (see 
figure below).  

 

2. Select Done.  

 You will be directed to the cInputsMaintenance worksheet. 
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cInputsMaintenance Worksheet 

NOTE: The cInputsMaintenance worksheet requires your selection of the rated culverts, which are 
compiled into this list, that have maintenance work programmed and funded, have maintenance work 
planned with funding applied for, and need maintenance work but are neither programmed nor 
planned.  

1. Select any culvert that has or should have maintenance performed on it by check marking the culvert 
in column A (see figure below).  

 

 The Likelihood of Failure column will automatically populate (see figure above). 
 

2. Select the Consequence of Failure using the dropdown list (see figure below).  
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 The Priority column will automatically populate (see figure above). 
 

NOTE: The Priority ranking is determined using the Criticality Matrix. To learn more about the 
Criticality Matrix, select any instance of a blue question mark to be taken to the CulvertFAQs 
sheet (see figure below). Select Done on the CulvertFAQs sheet to return to the previous sheet. 

 

 

3. Select Work Type from the dropdown list. 
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4. Select Primary Work Activity from the dropdown list (see figure below). 

 

5. Fill in the work details in the Work Details column (see figure above). 

6. Fill in the estimated cost in the Estimated Cost column (see figure below). 
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7. Select the year from the dropdown list in the Work Scheduled – Year column that represents when 
the programmed and funded maintenance work or the planned with funding-applied-for maintenance 
work is scheduled (see figure below). 

NOTE: In most cases, the current year should be selected. If an agency programs (with funding) or 
plans (with funding applied for) culvert maintenance projects more than a year in advance, a 
subsequent year may be selected. If a culvert maintenance project is necessary but has not been 
programmed or planned, then “GAP” should be selected. 
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8. Select the quarter from the dropdown list in the Work Scheduled – Quarter column that represents 
the quarter in which the maintenance work is scheduled (see figure below). 

 

9. Select whether the work is in-house and/or contracted from the dropdown list in the In-House OR 
Contracted column (see figure below). 

 

10. Select whether the maintenance work has funding awarded, funding applied for, or is a gap project 
from the dropdown list in the Funding Award, App, or Gap column (see figure below). 

NOTE: If a year has been selected in the Work Scheduled – Year column, the dropdown list will have 
the options “Awarded” and “Applied” (see figure below). However, if “GAP” has been selected in 
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the Work Scheduled – Year column, then the dropdown list will have the option “GAP” (see figure 
below). 

 
 

11. Fill in the Funding Type column (see figure below). 

12. Fill in the Funding Source Name column (see figure below). 

 

13. Select Done.  

 You will be directed to the cInputs1 worksheet. 
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cInputs1 Worksheet 

NOTE: The cInputs1 worksheet contains fields for the information that will display on the culvert 
dashboard.  

1. Fill in your preferred target percentage of culverts to be rated good and fair in Box A (see figure 
below). 

NOTE: The default target is set at 95%.  

 

 

2. Verify that Box B is the same value as Box 1.1. If the values are different, select Update Box B (see 
figure above). 

3. Fill in Box 1.5 with the number of culverts no inventoried and/or unknown (see figure below). 
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4. Select “estimated” or “actual” from the dropdown list in Box 1.5b (see figure above). 

NOTE: You can select Culvert Types (refer to figure after Step 1) to see a list of the quantities of 
different culvert types present in the agency’s inventory (see figure below). 

 

 

5. Select Done. 

 You will be directed to the cInputs2 worksheet. 
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cInputs2 Worksheet 

NOTE: The cInputs2 worksheet contains fields that will be used to customize your culvert AMP 
template.  

1. Fill the requested information for Box A through Box F. 

 

 

NOTE: The publication year box should be prefilled with a year that was entered when completing 
the CulvertData worksheets (see step 6).  

 

2. Select a number-of-years cycle from the dropdown list in the The culvert asset management plan will 
be updated every… box (see figure above). 

3. Fill in a website in the The culvert asset management plan can be found on our website, here… box. 
(see figure above). 

4. Select Done. 

 You will be directed to the cInputs3 worksheet. 
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cInputs3 Worksheet 

NOTE: The cInputs3 worksheet contains fields that will be used to customize your culvert AMP 
template.  

1. Select the condition of your agency’s culverts from the dropdown list in Box A (see figure below). 

 

 

2. Fill in a description of factors impacting your asset management activities in Box B (see figure 
below). 

 

3. Select your agency’s intentions with regard to condition monitoring actions from the dropdown list 
in Box C (see figure above). 
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4. Select whether your agency will achieve its asset management goals from the dropdown list in Box 
D (see figure below). 

 
5. Select Done. (see figure above). 

 You will be directed to the CulvertDashboard worksheet. 
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CulvertDashboard Worksheet 

NOTE: The CulvertDashboard worksheet produces an image that will be used to customize your 
culvert AMP template. You can also export the image independently of producing a customized 
culvert AMP template. 

1. Review the information presented in the culvert dashboard for accuracy(see figure below). 

 

NOTE: Any changes that are needed for the data presented in the culvert dashboard must be made in 
the CulvertData worksheets and the cInputs1 worksheet.  
 

2. Select Done. (see figure above). 

 You will be directed to the CulvertCharts worksheet. 
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CulvertCharts Worksheet 

NOTE: The CulvertCharts worksheet produces charts that will be used to customize your culvert 
AMP template.  

1. Review charts for accuracy (see figure below). 

 

 

2. OPTIONAL: Modify charts: 

a. Select Edit Data (see figure above). 

b. Change colors, label positions, fonts, etc. as desired. 

3. Select Done. (see figure above). 

 You will be directed to the CulvertTOC worksheet.
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CulvertTOC Worksheet 

NOTE: The CulvertTOC worksheet serves as an access point to the various worksheets in your workbook, 
and becomes available for viewing once finished with the Instructions worksheet. Where options exist, 
check boxes will indicate selections made by the user; these selections can be changed here. The 
CulvertTOC worksheet also serves as the location from which you can build your customized culvert 
asset management plan templates (see figure below). 

 

Build a Standalone Culvert Asset Management Plan 

1. Select Generate standalone Culvert AMP Word template on the CulvertTOC worksheet (see 
figure below). 
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 The Do you have any open instances of Word… dialogue box will display (see figure below). 

 

2. Select Yes or No (see figure above).  

 If YES: The process will end, and you will now be able to save and close any open instances of 
Microsoft Word.  

 If NO: The PLEASE NOTE: This process takes 3 to 5 minutes … dialogue box will display (see 
figure below).  

 

3. Select OK (see figure above).  
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 The process will continue until the Your culvert dashboard JPG image has been created dialogue 
box displays (see figure below). 

 

NOTE: If this is not your first time generating a culvert AMP using the tool, you may receive the 
prompt “A file named ‘C:\Users\...\culvertap-csvdata.csv’ already exists in this location. Do you 
want to replace it?”. Select Yes if you have updated your data since the last time you generated a 
culvert AMP or if you initially built a compliance plan culvert insert and are now building a 
standalone culvert AMP template (see figure below). 

 

4. Select OK in the Your culvert dashboard JPG image has been created dialogue box (see figure in 
step result above). 
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 The process continues to its conclusion when the Your customized template is ready to read and 
modify dialogue box will display (see figure below).  

 

5. Select OK. 

 At this point, you will have a standalone culvert AMP customized template 
“CulvertAMDoc_v####_[AgencyName]_customizedtemplate.docx” in the culvert tool folder (see 
figure below). Proceed to the section Reviewing and modifying the customized Word template in 
this instruction guide. 
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Build a Compliance Plan Culvert Insert 

1. Select Generate standalone Culvert AMP Word template on the CulvertTOC worksheet (see 
figure below). 

 

 The Do you have any open instances of Word… dialogue box will display (see figure below). 

 

2. Select Yes or No (see figure above).  

 If YES: The process will end, and you will now be able to save and close any open instances of 
Microsoft Word.  
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 If NO: The PLEASE NOTE: This process takes 3 to 5 minutes … dialogue box will display (see 
figure below).  

 

3. Select OK (see figure above).  

 The process will continue until the Your culvert dashboard JPG image has been created dialogue 
box displays (see figure below). 

 

NOTE: If this is not your first time generating a culvert AMP using the tool, you may receive the 
prompt “A file named ‘C:\Users\...\culvertap-csvdata.csv’ already exists in this location. Do you 
want to replace it?”. Select Yes if you have updated your data since the last time you generated a 
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culvert AMP or if you initially built a compliance plan culvert insert and are now building a 
standalone culvert AMP template (see figure below). 

 

4. Select OK in the Your culvert dashboard JPG image has been created dialogue box (see figure in 
step result above). 

 The process continues to its conclusion when the Your customized template is ready to read and 
modify dialogue box will display (see figure below).  

 

5. Select OK. 
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 At this point, you will have a standalone culvert AMP customized template 
“CulvertAMP_v####_[AgencyName]_customizedtemplate.docx” in the culvert tool folder (see 
figure below). Proceed to the section Reviewing and modifying the customized Word template in 
this instruction guide. 
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Reviewing and modifying the customized Word template 

Inserting logos 
The bridge asset management plan should incorporate your agency’s logo on the title page. A picture 
placeholder indicates where the logo should be inserted.  

To insert the logo into a Picture placeholder: 

1. Select the Picture placeholder (see figure below) where you plan to insert a logo or graphic (not a 
chart).  

2. Select the icon in the center of the placeholder. 

 The Insert Pictures dialogue box will display (see figure below). 

3. Select Browse > in the From a file option row in the Insert Pictures dialogue box (see figure below).  
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4. Navigate to your desired image using the Insert Picture window; select the image and then select 
Insert (see figure below). 

 The Picture placeholder will be replaced with the selected logo or graphic.  
 

Formatting images 
 
NOTE: A number of images are placed in the customized Word template during the generation process. 
Images should be formatted with Body style in the Styles group (see figure below). To delete an image, 
select the image and press the Del key on your keyboard.  
 
In some cases, images will require image text wrapping. To apply text wrapping: 
 

1. Find and select the image that needs text wrapping (see table below for locations of images in the 
Word templates). 
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Standalone Culvert AMP Compliance Plan Culvert Insert 

  

  

 

 

 

2. In the Layout ribbon, select Wrap Text in the Arrange group and select Top and Bottom from the 
dropdown list (see figure below).  
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 Text wrapping will be applied, but the placement of the image may not be as desired (see figure 
above). 

3. Select the text-wrapped image (see figure below). 

 

4. Move the image up or down to the desired position by selecting the image, holding down the left 
mouse button, and dragging the image (see figure below). 
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NOTE: In some versions of Word, green guidelines will help guide image placement with regard to 
alignment (left/right justified and/or centered) (see figure above).  

5. When the image is in the desired position, release the left mouse button (see figure below). 

 

 The image now has text wrapping and is placed as desired (see figure above). 
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Formatting tables  
 
NOTE: A number of tables are placed in the customized Word template during the generation process. 
Tables will generally have Normal style in the Styles group. In some cases, tables will need additional 
formatting. 
 
To add table/cell borders: 
 

1. Locate the top left corner of the table and scroll over the table (see figure below). 

 
 

 The table handle (tiny square containing a four-pointed/cross arrow) will display in the top left 
corner of the table (see figure above). 
 
NOTE: The table handle can be used to select the entire table or to access additional editing features. 
 

2. Right-click on the table handle (see figure below).  
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 A dropdown list of options will display (see figure above). 
 

3. Select Table Properties… from the dropdown list (see figure above). 

 The Table Properties window will display (see figure below). 
 

4. On the Table Properties window Table tab, select Borders and Shading… to access borders and 
shading options (see figure below). 
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 The Borders and Shading window will display (see figure below). 
 

5. Select the Borders tab. 

6. Select borders and/or shading attributes (see figure below): 
 
To change line style (e.g., solid thin line, solid thick line, dotted line), use the Style selection box. 
 
To change line color, use the Color selection box. 
 
To change line width, use the Width box. 
 
To apply line style, color, and width selections, turn off the desired border in the Preview box using 
the border identification buttons along the left and bottom of the preview; then, turn on the desire 
border. 

 

 Selections should display in the Preview area (see figure above). 
 

7. Select OK in the Borders and Shading window (see figure above). 

 Changes will be applied (see figure above). 
 

8. Select OK in the Table Properties window. 
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To adjust column widths: 
 

1. Scroll over the desired column border until the double-sided arrow displays (see figure below). 

 
 
 
NOTE: No particular cell should be selected. If a cell is selected, only the column border of that cell 
will be affected. 
 

2. Left click on the column border while the double-sided arrow is still displayed (see figure above). 

3. Drag the border to the left or right (see figure above).  

4. When the border is in the desired position, release the mouse button (see figure above). 

 

To adjust a table when the border is beyond the page width: 
 

1. Follow To add table/cell borders step 1 through step 3, above. 

NOTE: When an entire table is selected, there will be a tiny square containing a four-pointed arrow 
in the top left corner of the table (see figure below). 
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2. On the Table Properties window Table tab, check Preferred width and set the number as any 
number less than 7 (see figure below).  

 

 Text wrapping will be applied, but the placement of the image may not be as desired (see figure 
above). 

 

3. Select the Column tab. 

4. On the Table Properties window Column tab, check Preferred width and set the number as any 
number less than 7 (see figure below). 
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5. Set the column width as desired.  

NOTE: Some of the tables may extend beyond the width of the page. The following settings can be 
used: 
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Table: Planned Action for This Year Table: Unplanned Backlog 
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6. Select Next Column. 

 The selected column will advance. 
 

7. Repeat until all columns have been addressed. 

 

To distribute table columns evenly: 
 

1. Select two entire columns. 

NOTE: When an entire table is selected, there will be a tiny square containing a four-pointed arrow 
in the top left corner of the table (see figure below). 
 
 
 

2. Right-click on the highlighted column. 

 A dropdown options list will display (see figure below). 
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3. Select distribute columns evenly (see figure above). 
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  The cost projection/gap table will be placed in the selected Word template. The You can copy this 
table to another Word template… message box will display (see figure below). 

 

1. Select Yes to insert the cost-projection/gap table into your compliance plan template (or bridge asset 
management plan template). Repeat steps 3, 4, and 5; and proceed to step 7. 

OR 

Select No to skip inserting the cost-projection/gap table into your compliance plan template (or 
bridge asset management plan template). Proceed to Creating Financial Resources Content section 
of this instruction guide. 

2.  Open the Word template and format table as desired (see figure below). 
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Creating A Map of Culvert Assets in Roadsoft 
The culvert asset management plan should contain a map of your county’s culverts and their condition 
assessments. In Roadsoft: 

1. Select Culvert from the layer window on the left side of the screen (see figure below).  

 A prompt will display if the bridge data needs to be imported; the data will important. To re-import 
bridge data, right-click on the Bridges category and select Re-Import Bridge Data. 

2. Select the Legend Builder icon.  

 The Legend Builder window will display. 

3. Select Good/Fair/Poor Rating from the dropdown list in the Legend Builder window (see figure 
below).  

4. Select the Good, Fair, and Poor values so that they are highlighted blue (see figure below).  
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5. Select Add Selected Unique Value(s) (see figure below).  

6. Change the color of the bridges based on their condition under Item Properties: (see figure below). 

7. Select Apply.  

 The bridges on the map will turn colors according to their respective condition. 
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8. Add a filter to display bridges based on ownership. 

a. Select Filter Builder from the Filter tab located above the map. 

b. Search for “owner” in the search bar of the Filter Builder window (see figure below).  

c. Add the desired value option. 

d. Select Apply as Filter. 

e. Check to make sure only the bridges owned by the value chosen are displayed on the map. 
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Appendix 

Opening the uncustomized Word template 
Opening the BridgeAMP.docx Word template will immediately cause Microsoft Word to confirm the 
mail-merge link between the Word template and the Excel spreadsheet data, which was established in the 
TOC Worksheet’s Build a Bridge Asset Management Plan Step 8. To confirm this link: 

1. Open the BridgeAMP.docx Word template. 

 A Microsoft Word warning box will display.  

 

2. Select Yes. 

 The File Conversion window will display (see figure below).  

3. Select Windows (Default) in the File Conversion – [yourcsv].csv window, and select OK (see 
figure above). 

 The [yourcsv].csv file is now linked to the Word template and the data has been imported into the 
document. 
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4. In the Mailings ribbon, select Preview Results in the Preview Results group to preview the 
document with this auto-filled data (see figure below). 

 Scroll through the document: Text fields previously enclosed with double-right and double-left 
carets (e.g.: «Agency_NameAbbreviation») should now be replaced with the appropriate data 
from the Excel spreadsheet. 

 

 

Manually linking the Excel spreadsheet data to the Word template 
The Excel spreadsheet data can be linked manually to the Word template. To re-link the Excel 
spreadsheet data within the Word template and auto-fill corresponding text fields: 

1. Open the BridgeAMP.docx Word template. 

2. Select the Mailings ribbon. 

3. In the Mailings ribbon, select the Select Recipients from the Start Mail Merge group; then, select 
Use an Existing List from the dropdown menu. 

 

 The Select Data Source dialogue box will display. 
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4. Navigate to the save location for your exported .csv file using the Select Data Source window; then, 
select the Excel file and select Open. 

 The File Conversion window will display (see figure below).  

5. Select Windows (Default) in the File Conversion – [yourcsv].csv window, and select OK (see 
figure above).  

 The [yourcsv].csv file is now linked to the Word template and the data has been imported into the 
document.  

6. In the Mailings ribbon, select Preview Results in the Preview Results group to preview the 
document with this auto-filled data (see figure below) 
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 Scroll through the document: Text fields previously enclosed with double-right and double-left 
carets (e.g.: «Agency_NameAbbreviation») should now be replaced with the appropriate data from 
the Excel spreadsheet. 

 

Manually reviewing the template for errors and finalizing 
Once the bridge asset management plan .csv file has been created, it will be automatically linked to the 
BridgeAMP.docx template. The template should then be checked for unfilled text fields that should have 
been replaced with required information. This check should be done to ensure that no text field is 
overlooked and forgotten. To check the template: 

1. In the Mailings ribbon, select Check for Errors in the Preview Results group.  

 The Checking and Reporting Errors dialogue box will display.  

2. Select Complete the merge, pausing to report each error as it occurs, and select OK. 

 Word will prompt you to complete any unfilled text fields using a Microsoft Word information 
prompt window, such as the one below.  

3. Enter in the requested information in the Microsoft Word information prompt window, and select 
OK. 

4. Repeat step 3 until there are no more Microsoft Word information prompt windows remaining.  

 Microsoft Word will generate a new file, named Letters 01.docx, of your final asset management 
plan. 
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5. Save Letters 01.docx with a unique name—such as BridgeAMP-2020.docx—in the desired location 
on your computer (see recommended save location information on page 1).   

 

 

Finalizing the template 
Once the BridgeAM-Data.xlsm and BridgeAM-Budget.xlsm processes are complete, you can access and 
finalize your customized bridge asset management plan Microsoft Word template. To finalize the 
template: 

1. Open BridgeAMP_v####_[youragency].docm located in the tools parent folder (see figure below). 

 

2. Select the checkmark button at the top of the Word document window to finalize the plan (see figure 
below). 
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 The tool will produce a finalized Word document, BridgeAMP_v####_[youragency]_final.docx. 
You will need to customize this document to include the Roadsoft map of bridge assets and to 
communicate your agency’s unique bridge asset story. 

 

Manually updating Table of Contents 
The Contents field will appear as a list of links after the mail merge (see figure below). To fix this, the 
table must be deleted and replaced. 

1. Go to the Contents section on the second page of the document. 

2. Select the Contents field.  

 The Contents listing will appear boxed with buttons located in the upper left corner of the field.  
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3. Select the three dots. 

 

 The entire table of contents will become highlighted. 

4. Press the backspace or delete key on your keyboard to delete the entire table of contents. 

5. From the References ribbon, select Table of Contents, and then select Automatic Table 1 from the 
dropdown list. 

 A new and updated Contents will replace the old one on page two of the Word document (see figure 
below). 

6. Repeat these steps with the Table of Figures and the Table of Tables. 
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Manually inserting Microsoft Excel charts/graphs into Word 

1. In an Excel spreadsheet, select a chart/graph (as shown below).  

2. In the Home ribbon, select Copy from the Clipboard group to copy the chart/graph to the 
Windows clipboard. 

OR: Right-click on the chart/graph; select Copy from the dropdown menu. 

OR: Use the Ctrl + C keyboard shortcut. 

3. In the BridgeAMP.docx Word template, select the Picture placeholder (shown below) and press 
the Delete key on your keyboard.  

4. In the Home ribbon, select Paste from the Clipboard group to paste the chart/graph that was 
copied to the Windows clipboard. 

OR: Right-click on the placeholder; select Paste from the dropdown menu. 
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OR: Use the Ctrl + V keyboard shortcut. 

 

 The copied chart/graph will display in the Picture placeholder. 


